
 
DAT/EM Systems International 
8240 Sandlewood Place, Suite 101 
Anchorage, Alaska USA 99507 
Phone (907) 522-3681 
Support Department Email: support@datem.com 
Web: www.datem.com  

RELEASE 6.7 Product Notes
November 30, 2012

 
Page 1 of 40 

 
 

 

 

The following changes have been made to DAT/EM products between Release 6.6 and Release 6.7. Please review these 
revisions made to the software and update your software to implement changes. 
 
As always, DAT/EM welcomes comments and suggestions from you, our clients, so please don’t hesitate to contact our 
support department at support@datem.com, or by calling in or faxing us with your requests. 
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Operating Systems 
Release 6.7 is supported on Windows XP Professional and Windows 7 Ultimate or Professional operating systems. 
Testing no longer occurs for Windows 2000 or Windows Vista. If you have a question, please contact Support. 

CAD Versions 
Release 6.7 has interfaces to the following 32-bit and 64-bit CAD versions: 

 AutoCAD: Autodesk 2004, 2005, 2006, 2007, 2008, 2009, 2010, 2011, 2012, and 2013 products. DAT/EM software will install 
for multiple AutoCAD products of different year numbers on the same computer; however, it will not install for multiple same-
year versions together. For example, it will not install for both 2012 and Map3D 2012. Please note that files may be copied 
manually to activate more same-year versions (contact DAT/EM Support for instructions).  
BE ADVISED: Version 6.6 and higher no longer support AutoCAD 2000-2002 versions. If you use these old versions, please 
upgrade to AutoCAD 2004 or higher. AutoCAD version 2007 or higher is needed in order to use the new MAPEDITOR. 
 

 ArcGIS: ArcMap 9.1, 9.2, 9.3 (service pack 1), 9.3.1(service pack 2), 10.0 (service pack 4), and 10.1 (service pack 1). 
Version 6.7 is the first version to support ArcGIS 10.1. 
 

 MicroStation: MicroStation V8 and V8 2004 Edition, XM, V8i Select Series 1, 2, and 3 and Bentley Map Select Series 1, 2, 
and 3 are approved. Select Series 2 or 3 is recommended over Series 1. 
Note for Select Series 1-to-2, 1-3, or 2-4 upgrades: If you upgrade to MicroStation or Bentley Map from Select Series 1 to 
Select Series 2 or 3, you must reinstall any DAT/EM software after installing the Series upgrade. 

 

Hardware Locks/Dongles 
Please install Microsoft Updates and Service Packs for your operating system before applying lock reset programs. 
Network licensing should have the same Sentinel driver version on both the server and the local computers running the 
software. 
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Software Installation 
The following has changed for DAT/EM software installation: 
 

1. If using a network lock, either the IP address or the computer name of the network lock server may be entered. 
Previously, only the IP address could be used. 
 

2. A new set of C redistribution files is provided. Please answer “Yes” to install them as setup starts. 
 
Video Drivers 
Please note the slight change to our video driver installation/update recommendations: 

 DO NOT install the driver on media packaged with a video card. It will be too old. (This is the same.) 

 1st: Get the latest driver for your video card and operating system from www.nVidia.com. (This is different!) 

 2nd: If the driver on www.nvidia.com does not work, go to www.datem.com to download the driver there if it is 
different from nVidia’s currently offered driver. 

 If you need to change (update or back out) a video driver, please follow the instructions at www.datem.com 
Support > Downloads > Manuals > Installation Instructions>“StereoLCDInstallationInstructions.pdf”. This 
shows how to replace drivers and verify that the new drivers have been installed properly. 

 On existing workstations, check your video driver periodically. The easiest schedule is to check it before installing 
each DAT/EM software update, which happens about three times per year. If it is older than the one currently 
posted on www.nvidia.com, and especially if it is older than the one currently posted on www.datem.com, please 
update it. 

Newly posted nVidia drivers have become more reliable with the type of stereo used by DAT/EM products. Further notes: 

 DAT/EM posts drivers here: www.datem.com > Support > Drivers > Stereo-Viewing Systems. 

 When checking your installed video driver version, remember that the actual version consists of the last five digits 
with the decimal point moved two spaces to the right. For example, 6.14.12.7642 is really version 276.42. 

 To check the installed video driver version on Windows 7, right click anywhere on a blank area of the desktop. 
Select Screen Resolution > Advanced Settings > Adapter tab > Properties > Driver tab > Driver Version. 

 To check the installed video driver version on Windows XP, right click anywhere on a blank area of the desktop. 
Select Properties > Settings tab > Advanced > Adapter tab > Properties > Driver tab > Driver Version. 

 For video settings, see www.datem.com Support > Downloads > Manuals > Installation Instructions. Most 
users will want either “PlanarInstallationInstructions.pdf” for Planar monitors or 
“StereoLCDInstallationInstructions.pdf” for LCD stereo monitors. 

 

DAT/EM Keypad Advantage *New!* 
DAT/EM Keypad Advantage is a new DAT/EM Keypad product. The user supplies a Bluetooth® 
USB dongle and any tablet device running Android® OS version 4.0 or higher. A tablet 
computer is the most practical size, but a smaller device such as an Android cellular telephone 
may be used. Download the application for free from the Google Play® Store. Download 
installation instructions from http://www.datem.com Installation Instructions.  

Note that DAT/EM has tested Samsung brand tablets and telephones. 
Other brands should work, but have not been tested. 
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DAT/EM Keypad Controller 
The following change has been made to the DAT/EM Keypad Controller software: 

1. On some Windows XP workstations, the color table picker for the key’s background color in the Edit Key dialog 
would not display. The only way to select a different color was with the keyboard arrow keys. This has been fixed. 

 

Summit Evolution 
The following changes have been made to Summit Evolution and the applications that are provided with it. 

 

2. Button Manager has the following changes: 

 There are new Type=Plotter, Action=Lock X Toggle and Action=Lock Y Toggle options In Button 
Manager. The previously existing Lock XY Toggle option is still available. These enable you to set a 
digitizer button to lock the X direction or Y direction separately or lock both X and Y directions at the same 
time. 

 The Type=Plotter, Action=Zoom In and Action=Zoom Out buttons were being disabled when 
Summit>Tools>Options>Input Devices>Allow Zoom with Clutch was not checked. Now Zoom In and 
Zoom Out buttons are independent of the clutch zoom setting. 

   
“Allow zoom with clutch” no longer affects Plotter Zoom In and Zoom Out buttons 

3. Summit>Tools>Options>Main View>Tile>512x512 is a new setting in Options. Previously, all tiling was 
256x256 and could not be set by the user. 512x512 uses fewer tiles, so should make tiles load faster with 
OpenGL for most – if not all – modern video cards on modern computers. The 512x512 setting is especially 
important to use for JPEG2000 imagery (discussed in item 21.c on page 17). The 512x512 setting applies only to 
a single viewport; when two or more viewports are open, they will revert automatically to 256x256 tiling. 

 When version 6.7 is installed, 512x512 will be turned on by default for Windows 7 and 256x256 will be on 
by default for Windows XP. This is a general rule only; you may try the other setting. 

 If you have Windows 7 installed on an old computer, if you have an old video card (~10 years old), or if for 
any other reason you notice slow tiling and slow model loading, set 256x256 to see if it improves. 

 If you have a high-end computer with Windows XP and a new video card model, you may try 512x512 to 
see if tiling is faster. Many computers running Windows XP are capable of handling the 512x512 tile size. 

 

New Tile=512x512 and 256x256 settings 
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4. In the Image Adjustments dialog, you can now key in a minus sign, such as with “-5” to correctly replace the 
current setting for the following fields: Brightness, Contrast, Saturation, Sharpen, Red, Green, and Blue. 
Previously, the “0” or other current setting would not be removed, resulting in an unrecognized “0-5” setting 
instead of the desired “-5”, for example. 

5. The Project Histogram dialog now allows images to be checked on or off, and can process either all images or 
only checked images into histogram diagram files. Previously, it only processed all images. 

6. The new-as-of-v6.6 Cursor Ground Grid graphics now draw behind other superimposition components such as 
the cursor design and the elevation text. 

7. Control Transfer between two Summit Evolution instances using “Method 1” in pixel movement mode had 
problems: a) it might not display points that had been measured in the previously open image, and b) it might not 
display residuals in a second and subsequent image. These issues have been fixed. 

8. DAT/EM Drawing Objects tools have the following changes: 

 The Load Point file onto Layer tool was ignoring Lidar filters. This has been fixed. 

 Save Objects to File on the Drawing File toolbar can now save individually selected layers. Previously, 
all of the drawing objects would save at the same time into the same file. 

9. If a Group from the Project window Groups tab is open in a viewport when Project Viewer or Image Viewer’s 
Move Summit by Pick is used, and the picked point is outside of any group model, the picked model will be 
opened and the group canceled. 

10. Summit Evolution’s File>Export>Export Model Bounds>Send to CAD had problems writing the model name 
text and sometimes the boundary polylines in the AutoCAD file. It now writes them correctly. 

11. The Tie Points process for all applicable project type has the following changes: 

 It does not allow the same image to be opened for both right and left images in a tie points viewport. 

 Long file names can now be completely viewed in the Tie Points View Ports dialog’s Models list. 

12. The CAD command and layer text was positioned too high with multiple viewports on. Now the text has been 
moved down so that it is no longer displayed under the viewport title bar. 

   
Text display with respect to the viewport title bar before the fix (left) and now (right) 

 

13. Coordinate system transformation settings have the following fixes and changes:  

 If a project such as RPC had a default input coordinate system of WGS 84 and Ellipsoid height, and only 
a vertical transformation was applied, it would not immediately transform the Z values. It would transform 
them the second time the project was opened or if the WGS 84 settings were also reselected along with 
the vertical reference setting. This has been fixed to apply the vertical reference immediately after it is set. 

 The “EPSG Code” or “GC Code” is now displayed in the coordinate system listing in Project Edit and 
Coordinate Transformation dialogs. This is to help distinguish coordinate systems that have the same 
“System” name in the Blue Marble database. For example, several different WGS 84 selections were all 
listed as simply “WGS 84”; now they will also show the code, for example, “WGS 84 (EPSG:4326)”, which 
corresponds to the Geodetic > World > WGS 84 / WGS 84 / WGS 1984 / Degree / EPSG Code=4326 
setting in the Blue Marble Select Coordinate System from Datasource dialog: 
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14. There are two modifications that mostly affect the ability to delete models from the Project window: 

a. The Delete Models dialog has a new “Close model if currently open” checkbox. If it is on, the model closes 
and is deleted at the same time; if off, the model definition is deleted, but the two images stay open if they 
were already open. 

b. The right click menu on the Project window’s Models tab has a new “Delete this model” option and the options 
have been rearranged. This allows you to delete the single model directly under the cursor arrow pointer 
without activating the Delete Models dialog.  
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New “Close model if currently open” and new right click menu for Models tab 

15. The status bar now shows “NONE” or “__ Checked” whenever SI > Layer Manager has a setting other than All 
Layers. For example, 

 
Nothing appears when “All Layers” are set in the SI Layer Manager 

 

 
“__ checked” appears when certain layers are checked on in the SI Layer Manager 

 

 
“NONE” appears when no layers are on for display in the SI Layer Manager 

 

 
The icon to the left of “NONE” or “checked” activates the SI Layer Manager; 

it is the same as the icon on the SI Tools toolbar. 
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16. Aerial projects have the following changes: 

c. In the Project Edit dialog, the “Automatically select best stereo view” North, South, East, and West settings 
have changed. There are now four choices for the preferred north-on-screen direction: 

a) Up or Right – Models from east-west flight strips will open north up on screen. Models from 
north-south flight strips will open with north to the right on screen. 

b) Up or Left– Models from east-west flight strips will open north up on screen. Models from north-
south flight strips will open with north to the left on screen. 

c) Down or Right– Models from east-west flight strips will open north down on screen. Models from 
north-south flight strips will open with north to the right on screen.  

d) Down or Left– Models from east-west flight strips will open north down on screen. Models from 
north-south flight strips will open with north to the left on screen. 

Flight directions that are not exactly east-west or north-south will open as close to the set screen 
directions as possible. Sometimes the preferred screen direction will be overridden by a few degrees in 
order to keep the next automatically opened model from “flipping” almost 180 degrees. 

Any time you don’t like the display direction of the model, you may use the “Flip 180” icon on the Image 
View toolbar for a single viewport or from the viewport title bar when multiple viewports are open: 

  

 
Flip 180 buttons on individual viewports 

 

d. In the Camera Editor, when entering Distortion>Radial and Decentering values, it would not take the “e” 
character for scientific notation. This is fixed. For example, it is possible to enter -4.8e-005 
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e. Bathymetric Correction is a new tool on the Orientation menu for aerial projects. This correction is used 
when measuring underwater features. Underwater features need to be adjusted due to the refraction of light 
when passing into and out of the water medium. The correction is applied project wide. The correction only 
happens when the ground Z is under the user-supplied Water Level in the Bathymetric Correction dialog. 
The water level can be keyed in or measured using the Water Leve>Measure button. 

The Refraction Index can be modified by the user. The default is 1.333, which is the refraction index of 
clear water at 20ºC.  Temperature, salinity, and turbidity levels can change the index. 

There are two kinds of displays to indicate that Bathymetric Correction is enabled: 

 In the main view: When Summit’s cursor Z is under the water level and Display in view is on, the 
correction is displayed as text in the view. When above the water level, this display disappears. 
The incidence angles show how the correction changes as the angles change. 

 In the Summit status bar: When the correction is on, “Bathymetric Z” appears in the Summit 
status bar. This remains displayed, even when the Bathymetric Correction dialog is turned off and 
even when the cursor is above the water level. 

 

   
Bathymetric Correction settings and heads up display in the main Summit view 
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17. ADS40/80 projects have the following changes: 

f. It is now possible to position the bird’s-eye view at the upper edge of the view. 

g. There were some image view rotation issues that have been fixed. 

h. If a histogram .histohfa file existed for an open ADS40/80 image and Histogram Equalization was checked 
on in the Image Adjustments dialog, the image preview in the Image Adjustments dialog could turn white. This 
has been fixed. 

 

18. Satellite RPC projects have the following changes and additions: 

a. TIL (tile definition) files that have missing tiles inside can now be read properly.  

b. TIL files that “don’t tell the truth” can now be used to make a proper project. DAT/EM received satellite 
imagery with TILs where the images tiles not only overlapped, but the TIL files indicated that the overlap 
was 1000 pixels when it was really only 200 pixels. Summit now corrects for these problems. 

Our experience so far tells us that TIL files frequently contain mistakes, 
but that (so far!) we can find ways to work around the mistakes. If you 
have a problem setting up a project with TILs, contact DAT/EM Support. 

c. When TIL files are used and SMTI files are found in the same folder as the original image files called by 
the TIL, the SMTI file will be used. This means you can have Image Creator make SMTI files, and you do 
not need to move the original TIF/JPG2000/NTF files from the folder. Given Windows 7’s problems 
moving some large TIF files, this could save you time and avoid Windows crashes. 

d. NTF satellite imagery files previously had a 2GB file size limit. Larger files may now be used. This applies 
to Image Creator, Summit Evolution, and any other DAT/EM application that reads and displays images. 
DAT/EM recommends using Image Creator to input large NTF files and output SMTI with compression on 
and set to 85%. Our samples have shown that some large NTF files are stored as 16 bit, but are really 
only 11 bits of useful information and have many black pixels; therefore, compression will greatly reduce 
the file sizes. In one example, compression at 85% reduced a 7.9GB NTF file to a 2.2MB SMTI file 
without noticeable loss of resolution. If SMTIs are in the same folder as the NTFs, the SMTIs will be used. 

e. There is a new Add Multiple button in the RPC project type. Add Multiple asks for a folder. It searches 
that folder and all its sub folders looking for all possible images, associated RPC files (RPC, RPB, or XML 
format), and existing TIL files. It adds the files to the project. It generates TIL files if needed. 

Add Multiple may be used for any brand of RPC imagery. It is particularly useful for imagery that stores 
image and file sets in a folder tree and/or uses split imagery with TIL files. For example, Add Multiple is 
recommended for GeoEye imagery, which is split into smaller image tiles and supplied with TIL files. Add 
Multiple is required for Astrium© Pléiades imagery that is split into multiple image tiles, because Add 
Multiple can create the TIL file that shows how to fit the images back together. 

The following notes are for Astrium© Pléiades images in particular: 

In version 6.6, DAT/EM introduced the ability to add Pléiades imagery to the RPC project type; however, 
it could only use individual Pléiades images with individual matching RPCs. Pléiades satellite imagery is 
often split into multiple image tiles that share a common RPC (XML format) file. These tiles are supplied 
without a TIL (tile definition) file. Add Multiple automatically detects split Pléiades files and creates a TIL 
file to show how the multiple images fit together. Once this is done, the TIL file itself is treated as if it were 
a special kind of image that references other images in the correct order. The following are 
recommendations for purchasing Pléiades imagery, creating a project, and avoiding problems: 

 Order the Pléiades Level 1A stereo or tristereo imagery in either TIF or JPG2000 format. 
JPG2000 may be preferable due to Windows 7 large TIF problems. 

 For TIF files, process the images with the Image Creator set to SMTI. If the original TIFs and 
SMTIs are in the same folder with the TIL, the SMTI will be used. 
(Continued on next page.) 
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 Note: If you choose instead to use “New TIF and PYR” output, be very careful. Microsoft 
Windows 7 has known problems dealing with large TIF files. If the “New TIF” is placed in the 
same folder with the original TIF, Windows may fail to rename the new file “_new” to differentiate 
it from the original file, and the original file may disappear. Windows 7 can also lock up when 
copying or moving Pleiades TIF files; this is not DAT/EM’s problem, but rather Microsoft’s. 
DAT/EM strongly suggests you choose SMTI output instead of New TIF & PYR. 

 Pléiades JPG2000 files may be opened as they are, but be aware that JPG2000 is slower to load 
and tile than TIF. DAT/EM strongly recommends processing JPG2000 with the Image Creator set 
to SMTI and write the files in the original folder. If SMTI files are present, they will be used. 

 Create the project with Summit’s RPC satellite project type. Use the Add Multiple button for split 
tiles that use a common RPC file and need a TIL to be created. Add Multiple will also handle the 
case of a single file with a single matching RPC, so it is never necessary to use the simple Add 
button for Pléiades. Add Multiple can also handle folder structures where some sub folders 
contain split images and other folders contain single images. 

f. All RPC projects – including imported satellite RPC from BLK format – have greatly improved tie points 
and control points bundle adjustment capabilities. This affects satellite projects with multiple adjoining 
models. The same tie or control point may be measured in multiple models, and the bundle adjustment 
will be calculated accordingly. Please note that while this is greatly improved, it has some limitations for 
larger multiple-model projects. The following is basic information on what it does well and what it doesn’t: 

 Given ground control points (GCP) measurements in every model, we can perform a bundle 
on a large number of photos. Triple and more overlap points are considered. The bundle 
adjustment works great. After calculating the adjustment parameters, there is no problem 
generating and outputting refined RPCs. 

 Do not expect perfect results if there are no GCPs or some models do not have GCPs. The 
bundle adjustment may not work as well on tie points only. Tie points are measurements that 
may or may not have good ground values, because we know the original RPC can be far off 
from actual ground coordinates (when not yet corrected with ground control point 
measurements). Two or more RPCs can be used to perform a 3D reconstruction to find 
ground coordinates for the tie points. This works great; however, bridging the tie points is still 
a weakness. It is not a complete bridging, because it does not weight the GCPs, and the 
solution can be less than perfect. For smaller satellite projects, the above methods will work 
fine for projects that originate in Summit. It should not be applied to larger projects that 
originate in Summit. However, we can import BLK projects that are larger, because in the 
BLK, all ground values are known, even for tie points. 

 If you are planning a very large satellite RPC project, please discuss it with DAT/EM Support 
before you begin. Let us know how many models, the imagery source, and the availability of 
GCPs. We can help you evaluate the project. 

g. Control transfer is now allowed for RPC projects. Sources for the control readings are the same as for 
other projects’ Control Transfer: An orthophoto plus a points file, a 3D vector file, or a second Summit 
instance with an oriented project of the same geographic area. The procedure is the same as for Control 
Transfer for aerial projects. Please note that the destination coordinate system of the RPC project must 
match the coordinate system of the control points coming in from the outside source. 

h. The Auto Next button is now on by default in the RPC Tie Points dialog. 
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h. Summit can now import BLK that are satellite RPC projects. It imports the original RPC data and any tie 
and ground control measurements. Use File>Import>BLK. 

 

 If the coordinate system is set to UTM in the BLK, the same UTM coordinate system will also be 
set in the Summit projects. For any other coordinate system, the user must set the proper 
coordinate transformation in the Project Edit dialog (Edit>Project) after the import is complete. 

 The Summit project’s destination coordinate system must match the coordinate system of the 
control points that were used to create the original BLK. Any other coordinate transformation is 
not allowed and will not produce good ground coordinates. 

 If the images are not epipolarized, first import the BLK and set the correct output coordinate 
system. Then run Summit>Imagery>Satellite epipolar to make a project that has improved 
stereo viewing. (Note: If you plan to run Satellite epipolar, uncheck Create Match-T compatible 
projects in the Import BLK dialog; the projects will be made from the epipolarized images later.) 

 The satellite bundle adjustment mentioned in 18.d. on page 9 also applies to imported satellite BLK 
projects. If there are tie points and ground control point readings in the BLK, the import process 
performs a bundle adjustment. 

 RPC Based Projects checkboxes: Create Match-T compatible projects and Create 
Alternative RPC projects operate as described in item 18.i. on page 12 below. 
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i. There are three new ways to create Inpho Match-T compatible RPC projects and other alternative RPC 
projects based on an original Summit RPC project file: 

1) File>Export>RPC create alternative projects is a new export tool 

2) Imagery>Satellite Epipolar has a new Create Match-T compatible projects setting 

3) File>Import>BLK for satellite projects has two alternative Match-T projects settings. See 
more about importing BLK files above in item 18.h on page 11 above. 

These options create more versions of the Summit RPC project that store their RPC information in an 
external _rpc.txt file. By contrast, the original Summit RPC project stores its RPC information inside the 
Summit .smtxml file.  

The settings are as follows: 

o Create Match-T compatible projects: Use this setting only if you intend to use the project in 
Trimble Inpho Match-T software and the imagery is already epipolarized or in the process of 
being epipolarized. This setting makes RPC projects where the RPC parameters are stored 
in separate files. One or two new folders will be made as follows: 

 …\Comp_MatchT folder: This folder contains generated RPC files in WGS84 
latitude-longitude units with a coordinate system conversion set in the project. 

 …\Comp_MatchT_sys folder: This folder is only made if there is a coordinate 
system (other than WGS84 latitude-longitude) set in the original RPC project. This 
folder also contains generated external RPC files, but the coordinate system is built 
into the RPC. No coordinate system conversion is set in the “MatchT_sys” project, 
since it is already in the destination coordinate system. For this type of project, you 
should never apply a coordinate conversion or use it to attempt further ground control 
point or tie point adjustments. If Match-T uses this project, then the resulting DTM will 
already be in the destination coordinate system. 

o Create Alternative RPC projects: The second check box is for making alternate RPC 
projects from an existing RPC project. The resulting projects will have “_alt.smtxml” and 
“_altSys.smtxml” names. The RPCs are stored internally in the files. The RPC are 
regenerated to incorporate all adjustments. All tie points and control measurements are 
removed. They are not needed, since the RPCs are already adjusted. The “_alt.smtxml” 
stores RPC in WGS84 latitude-longitude units. The “_altSys.smtxml” stores RPCs that are 
made in the final destination coordinate system. These are very similar to the Match-T 
projects described above with the exception that the RPC values are stored internally (hence 
can’t be used by Match-T). 

Q: Why make alternative RPC projects? 

A: The projects will open much faster, because no bundle adjustment of tie or ground 
points needs to be done (it’s built in!). Another big advantage to the _altSys.smtxml 
project is that superimposition (SI) will be extremely fast. This is because the RPC is 
already in the final coordinate system, so no Blue Marble coordinate conversion needs to 
be applied to incoming SI vectors. This is most likely the fastest project you could have, 
perhaps even faster than Aerial projects. 
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New File>Export to alternative RPC projects tool 

 

 
Imagery>Satellite Epipolar has a new Create Match-T compatible projects setting 
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File>Import>BLK has RPC Based projects settings (see also item 18.h above) 

 

 
Example of the external IKONOS-format _rpc.txt file that is created 

 

 

19. Superimposition has the following changes: 

i. In Capture for ArcGIS, Summit’s 3D Vector Split Window and multiple viewport Show 3D SI in viewport 
displays previously showed TIN-like lines on polygons. This has been fixed to show the polygon only. 

j. A problem was fixed so that superimposition draws correctly when the user is actively drawing an object at 
the time the next model automatically loads. 

k. Superimposition now updates automatically when a new Summit project or new CAD/GIS file is opened. This 
especially helps to synchronize the Summit SI Layer Manager. 
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20. Contour Creator has the following changes: 

a. A fix was made to DAT/EM Capture for MicroStation that enables Contour Creator to correctly write and 
erase/rewrite contours directly into an active MicroStation file. 

b. There is a new Division tab that lets you select whether or not to break up the input data for contour 
processing. If it is broken into parts, it lets you select the maximum number of data points in the areas. 

Contour Creator has always broken up the data in past versions; the default values now on the Division 
tab are the values used in past versions. Use the Default button to reset these values when necessary. 

Contour Creator breaks up the areas for two reasons: For faster processing and to avoid running out of 
memory. The contours are calculated in the areas and then joined together at the end. Sometimes when 
there is a gap in the input data or unusual input data, the join does not work and the contours are left 
disconnected. If this happens, you may wish to change the Division settings. Sometimes changing the 
settings shifts the breaking grid and helps avoid a problem area where contours remained disconnected. 

DAT/EM recommends you keep the setting on and at the default values unless you have a problem with 
contours remaining disconnected. 

Turn Division off only if the computer has enough memory to generate the whole project at once. It is 
possible for the user to make settings that will run the computer out of memory and crash Windows!  

The Output division areas [to CAD] grid is used for checking purposes. You may look at the contour 
joins at the grid lines and make sure they are joined correctly. 

 
New Division tab 
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For example, here division lines are written directly to the AutoCAD green AREA-DIV layer 

 

 

21. Image Creator has the following changes: 

a. NTF satellite imagery files previously had a 2GB file size limit. Larger files may now be used. This applies to 
Image Creator, Summit Evolution, and any other DAT/EM application that reads and displays images. 
DAT/EM recommends using Image Creator to input large NTF files and output SMTI with compression on and 
set to 85%. Our samples have shown that some large NTF files are stored as 16 bit, but are really only 11 bits 
of useful information and have many black pixels; therefore, compression will greatly reduce the file sizes. In 
one example, compression at 85% reduced a 7.9GB NTF file to a 244MB SMTI file without noticeable loss of 
resolution. If SMTI files are in the same folder as the NTF files, the SMTI will be used. 

Another option for large NTF files is to convert them to JPEG2000 (described in 21.c below). DAT/EM tested 
a 7.9GB NTF and converted it to a 55MB JP2. The resulting load and tile time in Summit was acceptable, 
although somewhat slower than the TIF/SMTI format. Please note that the compression for the TIF/SMTI 
uses the old JPG compression standard, while the compression for the JP2 uses the new JPEG2000 
compression standard. The TIF/SMTI has more resolution loss and higher file sizes, but is faster to load and 
tile in Summit. The JP2 has less resolution loss and smaller file sizes, but is slower to load and tile in Summit. 
In the end, it is up to the user to decide which to use. 

b. CR2 (Canon Raw Image) is a new image format that is recognized by Image Creator, Summit Evolution, and 
all other DAT/EM software that reads images. Since the RAW formats are somewhat like digital negatives, 
DAT/EM chose conversion parameters that make the image look “reasonable” and give fairly close results to 
those seen in Adobe® Photoshop®’s conversion method. 
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c. Image Creator has a new setting to output JPEG2000 format. DAT/EM’s intention is to offer JPEG2000 for 
creating orthophotos and mosaics, especially if the imagery is true 16-bit (with all 16 bits used) or has more 
than three bands. DAT/EM does not recommend that everyone change to using JPEG2000 for every project. 
It is a really great format for some tasks, but it is not as fast as TIF for viewing purposes. 

 
New Jpeg 2000 setting in Image Creator 

 JPEG2000 “pros” (good): Can compress any number of bands (the old JPEG compression 
standard only supported up to 3 bands); Has full 16-bit support (the old JPEG compression standard 
supported only exactly 8 or exactly 12 bits. Some imagery, although appearing to be 12 or 16 bit, 
does not use all the bits. Satellite imagery sometimes uses 11 of the 16 bits, which causes problems 
with the old JPEG standard.). Better quality lossless compression (the old JPEG compression 
standard was quite lossy); Stores resolution levels similar to zoom levels; Processes images larger 
than 4GB (the old JPEG compression standard had a 4GB limit). 

 JPEG2000 “cons” (bad): Slower than TIF in Summit. 

DAT/EM offers the following general recommendations: 

 Use JPEG2000 for imagery that is 4- or more-band and needs compression. 

 Use JPEG2000 if generating orthophotos and mosaics from 4- or more-band imagery. 

 Use JPEG2000 if generating orthophotos or mosaics with compression on and at least one resulting 
file is expected to be greater than 4GB. 

 If the imagery is 3-band or not being used to make orthophotos, use TIF or SMTI. 

 In the 3-band case where compression is on and each output file is expected to be less than 4GB, 
use TIF or SMTI. 

Iif the output is TIF, SMTI, or New TIF+PYR and compression is checked on, the older JPEG compression 
standard is used. The newer JPEG2000 compression standard is simply not part of the TIF specifications and 
should not be applied to TIF. 
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d. This function was available in version 6.6, but was left out of the 6.6 Product Notes. There is a new checkbox, 
Generate histogram file. When on, a .histohfa file is created at the same time as the image and/or image 
zoom levels. The .histohfa file contains a complete histogram analysis of the image. If it exists, it is used by 
Imagery>Project Histogram and the Imagery>Image Adjustments>Histogram Equalization setting. If it 
does not exist, the Histogram Equalization setting uses a smaller, less accurate sampling for the 
adjustment. Note that the same .histohfa files can be generated from the by Imagery>Project Histogram 
dialog. 

 

22. Point Translator has the following changes: 

a. When the output was set to “ASCII XYZ” with the extension “XYZ”, the coordinates would not be written to the 
file. This has been fixed. 

b. Tab delimited ASCII files can now be used as input. 

 

23. Image Viewer: When Summit has an aerial project open and Image Viewer has an orthophoto open in the same 
geographic area with the same coordinate system, Image Viewer will track smoothly with Summit and show 
ground coordinates. Note: Any coordinate system conversion settings in either application are independent of 
each other, so that they may be transformed separately (this is not a change). 

 

24. Generate Lidar Images: Both pixel scale radio buttons could be on at the same time, so that the user could not 
enter a custom pixel scale setting. This has been fixed. 
 

 

25. Project Viewer / Ortho+Mosaic has the following changes: 

a. The mosaic process has been fixed to properly create a 4-band mosaic from 4-band orthophotos. 

b. Create Mosaic now automatically adjusts the cache size based on the input orthophotos. This prevents 
crashes with large images. Important notes: 

 Please be aware there is still a 4GB limit on the size of the output mosaic TIF file. 

 If the 4GB limit is exceeded, the output image will look “jumbled”, with blocks of the image mixed 
up and appearing in the wrong areas. 

 Always use the calculator button at the lower right of the Create Mosaic dialog before generating 
the mosaic. If the expected image size is near or higher than 4GB, beware! 

 For up to 3-band images, use image compression or to make multiple smaller-area mosaics to 
preserve system resources. 

 Remember that the JPEG image compression standard supports only up to 3 bands. The Use 
JPEG compression setting will be ignored if the input orthophotos have 4 bands. 

 

c. The vector file loading process now loads vector files many times faster. 
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Landscape 
The following changes were made to LANDSCAPE: 

1. Building classification is a new tool to classify building roof tops and outside walls. Recommended settings: 

 Point spacing >= 1 point per m2  (the denser, the better) 

 If a project contains overlying files, use the DAT/EM Point Translator to tile the file into multiple separate 
files so that no files overlap. 

 
 

 
Zoomed in view of a Building Classification area 
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Points in Landscape before Building Classification 

 

 
Points in Landscape after both Building Classification and Water Classification 
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DAT/EM Capture for ArcGIS 
The following changes were made to DAT/EM Capture for ArcGIS: 

 Compatible with 32-bit versions of ArcGIS 9.1, 9.2, 9.3.1, 10.0, and 10.1 (each with the latest service packs installed) 

1. There is a new automatic method to enable and disable DAT/EM Capture. This is useful when using a network 
hardware lock and when DAT/EM software is installed on more computers than there are DAT/EM Capture 
licenses. A user who wants to use ArcMap, but does not want to use Summit and DAT/EM Capture can easily 
unregister the Capture dll before launching ArcMap. Select Windows Start > All Programs > Datem Software >  
Utilities > Capture Enable or Capture Disable. A dialog will appear; select Register or Unregister. Wait as the 
dll is registered or unregistered. Please note that this also enables/disables DAT/EM Capture for MicroStation and 
AutoCAD if they are also installed on the computer. 

2. The DAT/EM cursor on the ArcMap side is now configurable. There is a new Cursor tab on the DAT/EM Capture 
Options dialog: 

 
The cursor appears in ArcMap only when Use DAT/EM Cursor is on (highlighted) on the DAT/EM Capture Tools 
toolbar. By default, the same cursor that Summit is currently using is set, but they may both be set to different 
cursor designs. It offers the same .cursor files that Summit Evolution uses. Use Summit’s Tools>Cursor Editor 
to create and modify cursor designs. Please note that the cursor’s opacity setting cannot be rendered in the 
ArcMap view; therefore all vectors and shading will be 100% opaque. If there is semi-opaque fill in a cursor that 
you like in Summit, you may want to copy it to another name and edit the ArcMap version to turn off Filled. Cursor 
files are found in …\Program Files (x86)\Datem Software\Cursors (Windows 7) or …\Program Files\Datem 
Software\Cursors (Windows XP). 

3. The DAT/EM Capture Options (ArcMap side) > SI tab > SI Fill Polygons setting is now being saved properly. 

4. The arc drawing tool now functions properly in geographic (latitude-longitude) coordinates. 

5. Shift Vertex XY, XYZ, and Z tools now work properly with polylines. 

 This tool now ignores second picks that snap back to the original object. You may snap to anything 
except the original object. 

 The Shift using Stereoplotter>Vertical setting was shifting in (x,y,z). It has been fixed to shift in (z) only. 

6. Modify Feature with the Summit cursor on and using the Point-to-Point drawing tool could not snap to the same 
object two times in a row. This has been fixed. 

7. Summit’s CAD Toolbar Close option was not working for ArcGIS. Now it properly calls the DAT/EM Close 
Polyline tool. 

8. Summit’s SI Layer Manager was not operating correctly with ArcGIS geodatabases. It only worked with 
shapefiles. This has been fixed to work with both. 

 



DAT/EM Systems International RELEASE 6.7 Product Notes 

 22

9. SI Drape is a new tool that applies a Z value from a DTM/DEM file to 2D data layers so they can be 
superimposed in 3D in Summit Evolution. This does not affect the 2D source data on the ArcMap side. It may be 
used to avoid having to use the “2D SI” setting in Summit. This tool does not affect data layers that are already 
3D. 

To launch the tool from a button or the DAT/EM Keypad, use: 

CallCommand CaptureArcInfo.SIDraper 

To use the tool, select  Drape 2D SI Objects using a DTM from the DAT/EM Capture Tools toolbar. 

 

 

 
Browse for one or more point files to add to the list. Check on any files you wish to apply now. The list is saved 
between runs. Be aware that the list is not project dependent; please change the list if you change the project. 

The Vertical Offset is added to the Z value if it finds one. 

If the 2D object is outside of the DTM area, it won’t apply either a Z value or the offset. In this case, the object will 
be set to the current stereoplotter elevation. This will make the vector appear in the current view, but of course it 
will follow the stereoplotter Z and seem to move up and down along with the stereoplotter. If you see this 
behavior, check that the DTM area overlaps the geographic area of interest and is in expressed in the same 
coordinate system used by the Summit project. 

Point thinning will always be used. The points-in-use number is capped at 1,000,000 (one million) points. 

As always, binary DTM file formats will be faster. If the DTM file is not in the correct coordinate system or is not in 
a binary format, use the DAT/EM Point Translator to change the file. 

Note that the Z values applied to the vectors will only be as good as the accuracy of the DTM/DEM file. If desired, 
verify the DTM file extents and accuracy using Summit’s SI>SI Lidar tool. 

The initial superimposition update will take longer with SI Drape on. 
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10. Extend Line is a new editing tool that extends the end of a polyline to snap to another object (line, point, or 
polygon). To use: 

 Turn on classic snapping for both the line to extend from and the object to extend to. These may be on 
the same or different layers. 

 Select the Modify task on the DAT/EM Capture Drawing Tools toolbar. 

 Select either 2D or 3D snapping from the DAT/EM Capture Drawing Tools toolbar. Extend line… adds a 
new vertex. With 2D snap, the new vertex will snap in (x,y) only and keep the elevation of the extend-from 
line’s original endpoint vertex. 3D snap will snap the new vertex in (x,y,z) to the extend-to object. For 
example, set 2D snap to extend a driveway to a building roof, but use 3D snap to extend a driveway to a 
road. 

 Select the Extend… tool on the DAT/EM Capture Editing Tools toolbar or use a button or keypad key that 
includes the keyword ExtendLineEnd.. Snap to the end of the line to extend and snap to the destination 
object. 

 

 

       

                         

Results of Extend… to a polyline, polygon, and point 

11. Clip Line is a new editing tool that clips off (trims) the end of a line back to its intersection with another polyline or 
polygon. To use: 

 Turn on classic snapping for both the line to clip and the intersected object. These may be on the same or 
different layers. 

 Select the Modify task on the DAT/EM Capture Drawing Tools toolbar. 

 Select either 2D or 3D snapping from the DAT/EM Capture Drawing Tools toolbar. 2D snap will clip the 
line to the (x,y) of the intersection with the extend-to object; it sets the new endpoint z to the original z of 
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the clipped line. 3D snap will snap the intersection with the (x,y,z) of the clipped-to object. For example, 
use 2D snap to clip a driveway to a building roof, but use 3D snap to clip a driveway to a road. 

 Select the Clip one line… tool on the DAT/EM Capture Editing Tools toolbar or use a button or keypad 
key that includes the keyword ClipLineEnd. 

 For the first pick, snap anywhere along object to clip. 

 For the second pick, snap anywhere along the intersecting line or polygon. 

The shorter overlapping end of the first-picked line will be trimmed back to its intersection with the second-picked 
line or polygon. 

 

 

 
Results of the new Clip Line… tool 
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12. Cut Polygon with Existing polyline is a new editing tool. As the name indicates, it cuts a polygon along an 
existing polyline. To use: 

 Prepare a polygon and a polyline that crosses the polygon. 

 Select the Modify task on the DAT/EM Capture Drawing Tools toolbar. 

 Select either 2D or 3D snapping from the DAT/EM Capture Drawing Tools toolbar. If 2D snap is set, the 
elevation of the original polygon is used; if 3D snap is set, the elevation of the polyline is used for the new 
vertices on the polygon. (Classic Snapping Environment settings are not necessary.) 

 Select the Cut polygon with existing polyline… tool on the DAT/EM Capture Editing Tools toolbar or 
use a button or keypad key that includes the keyword CutWithExisting. 

 For the first pick, pick on or very near the polygon. 

 For the second pick, pick on or very near the polyline. 

 

            

 

Results of the new Cut polygon with existing polyline tool 

(objects selected for demonstration purposes) 
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13. DAT/EM Capture Auto Complete is a new tool that works in ArcGIS 10.0 and higher. It is similar to ArcMap’s 
own Auto Complete, except DAT/EM has made it better for mapping purposes. The differences between the 
versions is outlined in the following table: 

ArcMap Auto Complete DAT/EM Auto Complete 

Drawing must start inside 
one of the polygons with 
which it will share an edge. 

Drawing can start anywhere.  

The sketch must cross out 
of and back into at least 
one polygon. If it does not, 
the sketch disappears 
when finished. 

A sketch that does not cross or enclose any other polygons simply 
becomes a polygon with no shared edges. 

There is one rule, however: The sketch must come close to some polygon 
somewhere. ArcMap will not complete the sketch unless a polygon is 
“selected” (even if it is not involved in the operation!), so DAT/EM must 
search a radius and find some polygon – any polygon! – to hand over to 
ArcMap. This is not a DAT/EM limitation, but rather ArcMap’s. If the sketch 
does not complete due to being too far away from any other objects, please 
use Create New Feature instead of DAT/EM Auto Complete. 

There is usually no need to change tools to draw one auto complete 
polygon and one non-shared-edge polygon nearby. 

The layer of the new 
polygon must match the 
layer of the polygon(s) with 
which it shares edges. 

The new polygon may be on any polygon layer. It shares edges with 
polygons on any layer(s). 

For example, set the “Parking Lot” layer and draw a parking lot that shares 
edges with several buildings and sheds. 

Intersections with crossed 
polygons are always 
snapped in 3D. 

Intersections with crossed polygons can be snapped in 2D or 3D. 

For example, 2D snap mode makes it possible to draw a parking lot at 
ground elevation around a building rooftop, or draw a taller building roof 
adjoining a lower building roof. 3D snap mode would be used if the 
adjoining buildings were at the same elevation. 

The new polygon is always 
one exterior ring. It can 
cover other polygons. 

The new polygon has one exterior ring and may have any number of 
interior rings. Polygons that are completely inside the sketch will be cut out 
as interior rings. 

Layers that are currently off will not be used to cut out interior rings. 

Examples: A parking lot that has a building completely inside it will share 
the building edge as an interior ring. The outside of a grassland polygon 
can be drawn and share interior ring edges with lakes located inside the 
polygon. 

The Keyword for the Keypad or button programming: AutoCompleteTask 

To use DAT/EM Capture Auto Complete: 

 Select a polygon target layer from the ArcMap Create Features window. 

 Set 2D or 3D snap. (Note that snaps will be either all 2D or all 3D, and are determined by the snap mode 
at the time the sketch is finished. It is not necessary to pick snap points; cross the snap points instead.) 

 Turn off (uncheck in the TOC) any polygon layers that you do not want to be used as interior ring edges. 
This applies only to polygons that lie at the edge or inside the area where you will draw the new polygon. 
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 Select the DAT/EM Auto Complete tool from the task list on the DAT/EM Capture Drawing Tools toolbar 
or use a button or keypad key that includes the keyword, AutoCompleteTask. 

 

 Start the sketch. The first vertex can be either inside or outside other polygons. It should be somewhat 
near a polygon. 

 Draw and finish the sketch. Completely enclose polygons to become interior ring shared edges. To share 
an edge with an existing polygon, cross the sketch into and out of the polygon at the location where the 
shared edge starts and ends. Cross any number of polygons. Note that a sketch near another polygon, 
but that neither crosses nor encloses any other polygon becomes a new exterior-ring-only polygon. 

 Finish the sketch. 

 
Begin to draw near a polygon. Cross polygons to share edges; enclose polygons to make 
interior rings. Finish the sketch to auto complete the polygon and cut interior rings, if needed. 
This example shows one exterior ring and eight interior rings created. 

 

 
A sketch near another polygon, but that neither crosses nor encloses 
any other polygon becomes a new exterior-ring-only polygon. 
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14. Airfield3D has the following updates: 

 The Ellipsoid Height field setting specifications are not clear in the 18B document. A customer interviewed 
an FAA employee and learned that, “…all of the vertically measured items should be at the NAVD88 
elevation and all calculations in the attribute fields are based on vertical differences in NAVD88 
elevations. The Ellipsoid height attribute is the ground measurement of the object in ellipsoid height 
units.”  Changes have been made to Airfield3D to accommodate this interpretation. An Ellipsoid Offset 
field is now located at the lower right of the Airfield3D dialog. If the Ellipsoid Offset setting has a non-zero 
value, the offset will be added to the elevation. Please keep in mind that in the continental United States, 
the ellipsoid height is always lower than NAVD88, so the entry will most often be a negative number. If 
the Ellipsoid Offset field is left blank or set to zero, no offset will be applied. The Ellipsoid Height height 
will be saved for the next use of the dialog. 

 
 If a custom slope is active, its setting is now shown in the main display to remind the user. 

 Upon starting Arifield3D, no cursor was visible. The user had to select a cursor each time. This has been 
fixed. (This may have been a problem in early betas of v.6.7 only.) 

 The OIS Surface Condition is no longer incorrectly automatically populated. “Supplementary” or “Primary” 
can now be selected by the user. 
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DAT/EM Capture and MapEditor for AutoCAD 
Changes apply to: 

32-bit AutoCAD 2004-2013 versions with the latest service packs. 

64-bit AutoCAD 2008-2013 versions with the latest service packs. 

BE ADVISED: As of version 6.6, Capture no longer supports AutoCAD 2000-2002 versions. If you use these old AutoCAD 
versions, please upgrade to AutoCAD 2004 or higher before installing DAT/EM version 6.7. 

DAT/EM software will install for multiple AutoCAD products of different year numbers on the same computer; however, it will not 
install for multiple same-year versions together. For example, it will install for AutoCAD 2011 and AutoCAD Map3D 2012 together, 
but it will not install for both AutoCAD 2012 and AutoCAD Map3D 2012.  Please note that files may be copied manually to activate 
more same-year versions (contact DAT/EM Support for instructions). 

Autodesk Infrastructure Design Suite installs three same-year AutoCAD versions (AutoCAD, Map3D, and Civil3D). You must run 
each version and register/”accept” each one before installing DAT/EM software whether or not you intend to run every version with 
DAT/EM Capture active. DAT/EM software will install completely for only one of them. After that, the user can manually copy the 
AutoCAD \datem folder and the wintab driver file into the other two versions of AutoCAD. Contact DAT/EM Support for instructions. 

Reminder: Install all available AutoCAD service packs and updates before installing DAT/EM software. 

Reminder: After every new AutoCAD installation, you must run AutoCAD at least one time to activate its license before installing 
DAT/EM software. This applies to every version of AutoCAD on the computer whether or not you intend to use every  version with 
DAT/EM Capture active. 

The following changes were made to DAT/EM Capture and MapEditor for AutoCAD: 

1. There is a new automatic method to enable and disable DAT/EM Capture. This is useful when using a network 
hardware lock and when DAT/EM software is installed on more computers than there are DAT/EM Capture 
licenses. A user who wants to use AutoCAD, but does not want to use Summit and DAT/EM Capture can easily 
disable Capture before launching AutoCAD. Select Windows Start > All Programs > Datem Software >  
Utilities > Capture Enable or Capture Disable. Please note that this also enables/disables DAT/EM Capture for 
MicroStation and ArcGIS if they are also installed on the computer. 

2. EDITLINE has the following helpful changes: 

a. If it receives “editline” while the EDITLINE prompt is already displayed, it simply returns to the prompt 
again. Previously, it would user the “e” to start the “end” option, and the user might not realize that option 
had started. 

b. An incomplete "Editline End" will now return the polyline to its original state. This happens when the user 
activates “Editline End”, selects the breaking point, but hits Escape or Cancel instead of completing the 
edit. 

3. Summit Evolution’s File>Export>Export Model Bounds>Send to CAD had problems writing the model name 
text and sometimes the boundary polylines in the AutoCAD file. It now writes them correctly. 

4. There is a new Advanced OSnaps tool. The keyin is 
ADVOSNAPS. It allows you to set an exact list of layers to use for 
object snapping. 

When Activate OSnap layer filter is OFF, AutoCAD’s default 
snapping is used. Every layer is used for snapping. 

When Activate OSnap layer filter is ON, DAT/EM’s advanced 
snapping takes effect. Snapping is by specific layers. 

 When Include is ON, the checked layers will be used 
for snapping. Unchecked layers will be ignored. 

 When Exclude is ON, the checked layers will be 
excluded from snapping, while the unchecked layers 
will be used for snapping. Use this setting when all but 
just a few layers will be used for snapping. 
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When Attempt to preserve current settings (“preserve”) is ON, it will retain all settings as best as possible 
when a new drawing is loaded. In the case that a new drawing has exactly the same layers, the dialog layer list 
(and settings) will be identical to the previous drawing. If a newly loaded drawing only has some of the layers as 
the previous drawing, the intersecting layers will have the same setting as the previous, but the new layers that 
were introduced will default to checked on. When preserve is off, everything will be reset and Activate OSnap 
layer filter will be disabled when a new drawing is loaded. The dialog setting will be saved to the registry when 
the dialog is manually closed. If the dialog is shut down by AutoCAD when the AutoCAD application is quit, the 
settings will not be saved to the registry. 

ADVOSNAPS is located in the Measure<version>.arx application. 
This makes it available for DAT/EM Capture in all editions of 
Summit and stand-alone MapEditor installations.  

ADVOSNAPS has been added to DAT/EM’s installed toolbars and 
menus. For example, it is on the MapEditor toolbar and ribbon 
menu: 

 
 

5. MapEditor for AutoCAD has the following changes: 

a. Volume Calculation has a new setting to convert the output units. For example, if the ground units are 
feet, volumes could be output in cubic yards instead of cubic feet. 

b. XYZIn  and XYZOut have been updated to input/output multiline text. 

c. Clip Objects could give an error and fail to clip everything required. It could miss the last vertex of a 
closed polyline and clip as if there were a closing segment between the 2nd-to-last vertex and the 1st 
vertex. These issues have been fixed. 

d. Clip Around Text had trouble clipping all objects, especially if the extents of two text objects overlapped 
each other. This has been fixed. 

e. Clip Around Text has a new clipping buffer setting that allows you to clip an area larger than the exact 
text extents. 
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f. Clip has a new option to move the clipped segments to a different layer. Our MicroStation MapEditor 
users will recognize this as the equivalent of “Change Attributes Interior”. Choose one of the options: 

 Move clipped object(s) to layer to move the clipped objects to a single named layer. This option 
is most useful if all the clipped objects originate on the same layer. 

 Move clipped to prefixed layer to move the clipped objects to the layer name prefixed by the 
text in the field. This option is most useful if multiple layers will be clipped, because it keeps the 
clipped objects on separate layers from each other. 

 Delete clipped objects to erase the clipped objects (original functionality). 

 
 

DAT/EM Capture and MapEditor for MicroStation 
Changes apply to Capture for MicroStation V8/2004 Edition, MicroStation XM, and MicroStation V8i Series 1, 2, or 3 on 32-bit 
and 64-bit operating systems. Note: 

 MicroStation V8 and V8 2004 Edition: Version should be 08.05.00.34 or higher. 

 MicroStation XM and V8i Series 1: XM version should be 08.09.04.88 or higher. 

 MicroStation V8i, V8i-based Bentley Map and Map Enterprise Select Series 1, 2, and 3: Select Series 2 or 3 is 
recommended over Series 1. 

 If you upgrade from Select Series 1 to 2 or 3, you must reinstall DAT/EM software after installing the Series upgrade.  

The following changes were made to DAT/EM Capture and MapEditor for MicroStation: 

1. There is a new automatic method to enable and disable DAT/EM Capture. This is useful when using a network 
hardware lock and when DAT/EM software is installed on more computers than there are DAT/EM Capture 
licenses. A user who wants to use MicroStation, but does not want to use Summit and DAT/EM Capture can 
easily disable Capture before launching MicroStation. Select Windows Start > All Programs > Datem Software 
>  Utilities > Capture Enable or Capture Disable. Please note that this also enables/disables DAT/EM Capture 
for AutoCAD and ArcGIS if they are also installed on the computer. 



DAT/EM Systems International RELEASE 6.7 Product Notes 

 32

2. MapEditor has two new parameter file commands: Select Set (Setname) and Select Set (unselect). Select Set 
(Setname) is used to select all objects in an existing selection set. Select Set (unselect) clears the active 
selection. These commands are meant to “wrap around” a Generic Keyin in a parameter file; first select the 
objects, run the keyin, and finally clear the selection. 

Find the new commands in the Parameter File Editor’s Command list:  

 
Choose Select Set (Setname). Specify an existing selection set. 

 
Immediately after the Select Set (Setname) line, add the Generic Keyin line. 

Immediately after the Generic Keyin line, add Selection Set (Unselect). This command does not have a 
dialog. This command ensures that the objects will not be further edited by subsequent commands. THIS 
IS VERY IMPORTANT! Failure to clear the selection could lead to other commands operating on the 
selected objects! 

Example: Select objects, use the MicroStation drop complex command on the objects, and finish by 
clearing the selection: 
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3. MESCALLOP has a new setting. When the setting is off, the arcs are collected together into a complex chain. 
When the setting is on, individual arc elements are placed. 

 
New Drop Complex setting in MEScallop 
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4. The Selection Set Editor has a new Wizard button. This launches a wizard that has two functions: 

 
New Selection Set Editor Wizard button 

 

  
New Selection Set Editor Wizard and symbology choices for the new sets 

Make settings in the Wizard as follows: 

a. Create a set for each Level: This option creates a set for every level. Each created set will be named 
according to the originating level name. By default, all elements will be included and the symbology for 
the set will be “ByLevel”.  However, this may be configured any way the users wishes including wildcard 
(“*”) symbology: 

b. Used Levels Only ON: Creates a set for every level that has at least one object on the level. 

c. Used Levels Only OFF: Creates a set for every level, whether or not the levels are empty. 

d. Include Levels in Attached Models ON: Creates levels for the master file and all reference files. 

e. Include Levels in Attached Models OFF: Creates levels for the master file only. 
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f. Combine several sets into single set: This option combines two or more previously existing selections 
sets into a new set. Give the set a name, select the sets to include, and select OK. 

  

Either double click a level or select it and press the >> button to build a list of levels to combine 

 

The combined set now appears in the Sets list and can be further edited, if desired. 

If a set name already exists, the Wizard will ask the user what to do: 

 
Dialog appears for duplicate set names 
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5. CHANGE ATTRIBUTES EXTERIOR has the following changes and fixes: 

a. It was fixed to handle points correctly. Previously, points could cause a crash. 

b. It was fixed to properly handle elements that are completely outside the boundary element’s minimum 
and maximum range. Previously, it ignored these elements. 

c. It has speed and performance enhancements. 

 

6. SUMMIT_MODELS_AREA is a new command to produce a list of models and open them in Summit’s multiple 
viewports. First open the desired number of viewports in a Summit project that has ground coordinates. Then on 
the MicroStation side, start the SUMMIT_MODELS AREA command. Draw the boundary using the system mouse 
in the MicroStation view: Add vertices using the left mouse button and right click to finish. A list of models 
intersected by the boundary appears. Drag and drop models from the list into the viewports. 

 
List of models made by SUMMIT_MODELS_AREA 

 

7. DTM PROFILE was fixed for selection and projection problems. 

8. BKTRACK STREAM’s rubber band in Summit’s superimposition was fixed to extend from the last-added vertex 
instead of the first vertex. 
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9. DTMEDIT has a reorganized dialog and has added a cell name list. This enables the command to visit cells 
and/or points specifically. It also solves previous problems with cells, were no matter what the settings, it would 
either visit every cell in the whole file or no objects at all. 

 
New version of the DTMEDIT dialog 

 

10. MEVOLUME has the following changes and fixes: 

a. If the folder specified for the report file did not exist, neither the folder nor the report file would be created. 
The folder and file are now created properly. 

b. New options and output results: 

 Write a report file and/or write the results into the design file. 

 The name of the design file units (based on the master units setting) are written into the report. 

 Volumes in cubic master units are written into the report file. To change the units – for example 
from cubic feet to cubic yards – temporarily change the design file’s master units 
(MicroStation>Settings>Design File>Working Units). 
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 On MEVOLUME>Text Placement Options>Show Counter option, a beginning value for the 
counter may now be specified: 

 
New setting for MEVOLUME’s initial count number 

11. The superimposition Auto update on design load setting now works correctly. Previously, it would only update if 
the SI clipping flag was set on. 

12. CROSSCHECK’s add vertex option would change a complex shape header to the active level and attributes, 
while leaving the component elements at their original level and attributes. This has been fixed so that the header 
keeps its original level, color, weight, and line code. 

13. ZLABEL has the following fixes and changes: 

a. Added the ability to offset the text element with the “Upright to Guider” alignment on. The offset is in the 
positive direction of the guider’s segment at the crossing. 

b. The Zlabel Guiders > Change Settings dialog would appear in back of its parent dialog. It now appears 
in front. 

c. Text and cell placement text descriptions are now synchronized correctly with the current settings. 

d. The text element’s own Z value is now matched correctly to the elevation of the element being labeled 
with guider crossings. 

e. There was an overlap in some of the keywords used in TEXT SETTINGS and CELL SETTINGS for 
ZLABEL parfile/import/export settings. To address the issue, some of the CELL SETTINGS keywords 
were renamed to prevent overlap. Customers using ZLABEL to place both text and cells will need to 
modify their existing parameter/import/export files. This will not affect files that only place text. 
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f. There are new text and cell placement options that now appear near the lower edge of the dialog: 

 Place Cell and Place Elevation Text: These options were present previously on the individual 
tabs. They have been moved so that they are always visible, no matter which tab is active. 

 Place Prefix: When checked, the prefix is added to the beginning of the text string. For 
example, if the prefix is “Elevation”, and the Z value is 125, the character string will be 
“Elevation 125”. 

 Append Master Unit Label: When checked, the current MicroStation master unit label will be 
added to the character string. For example, if this is checked with meters as the master unit and 
the elevation is 125, “125m” will be placed. Also, adding to the example for Place Prefix above, 
if both the prefix and the master unit are on, “Elevation 125m” would be placed. 

   
New ZLABEL text and cell placement settings 

 

14. MECLIP has the following fixes and changes: 

a. It has been fixed for a case where it did not clip one object in the main file per boundary element in a 
reference file. The object in the main file might have the same file position “name” as the boundary 
element in the reference file. The object with a matching name was being ignored. 

b. A slight change was made to how selection set definitions are used by CLIP INTERIOR. Elements are 
checked against the boundary set and skipped if they fall in the boundary set. If the boundary set was 
defined as “All Elements”, all cells would be skipped, because they fall in the boundary set. Now, only 
closed elements are checked to see if they are in the boundary set. 

15. The intersection sort algorithm has been fixed to handle closed BSPLINEs correctly. Previously, it would treat the 
element’s end point as a start point. Affected commands are: CROSSCHECK, ROAD CLIP, LABELIT, and 
BREAK ELEMENT. 
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16. In previous versions, DAT/EM Contour Creator could trigger a MicroStation crash when writing contours directly 
into MicroStation V8i Select Series 2 and 3. This problem was in DAT/EM Capture for MicroStation, not Contour 
Creator. This has been fixed. 

 

17. For Select Series 3 compatibility, the following command interfaces were significantly changed to operate in a 
non-modal capacity: MVUSER, BREAKLINE FILTER, DEPRESSION, Selection Set Editor, DTM INSERT, DTM 
CALCULATE, DTM SETTINGS, DTM SAMPLE, DTM FENCE, CHANGE ATTRIBUTES INTERIOR, MEXPORT, 
and DTM PROFILE. 

18. The following commands needed minor changes to address Select Series 3 lockup/pick failure problems: LD CP, 
MVUSER, BUILDINGFRAME, SCALLOP, ZLABEL, CHANGE ATTRIBUTES, DTMDISTRIBUTER, BMARK, 
TOUCH, ELEVATE, VOLUME, class editor, CLIP CELL, ROADCLIP, CROSSCHECK, CLEARLEVEL, DELETE, 
EDBOX, EXPORT, GRIDIT, JOINIT, MAPSTRING, CHCELL, ROAD, SPOTX, STROKE, ZCHECK, CLIP, 
CLIPTEXT, CLOSELSTRING, CURVETOLSTRING, DELETE, DELETE66, EDBOX, MEXPORT, FILTER, 
FIXCOMPLEXHEADER, HATCH, INTERP, MEJOIN, LSTRINGTOCURVE, MECROSSCHECK, MEMOVE, 
MEPATTERN, PATTERN INTERIOR, MEPSQR, REPLACE CELL, REPLACE OBJECT, ROTATE, ROTATE 
TEXT, RUN MULTIPLE, SCALE, SMOOTH, STROKE, TEXT IN SHAPE, TOUCH BATCH, WEED, CHANGE 
CELL, CHANGE TEXT, CHANGE TEXT ELEVATION, CHANGE2D, and CHANGEWCC. 

19. The following commands were corrected to avoid memory corruption reading long registry entries: SCOP, 
LABELIT, GRIDIT, CHECKATTRIBUTES, CLOSELSTRING, CHECKATTRIBUTES, ATTACH REFERENCE, 
DTM SAMPLE, ZTEXTCELL, ZLABEL, ZCHECK, XYZIN, EDITPOINT, DTM POINT, DTM LOAD, BMARK, 
XSECT IMPORT, SPOTX, and MEASURE HEIGHT. 

20. Error checking was added for SRV, ADF, and CEAL, which are internally used commands (not user commands). 

21. LD CP DLG was fixed to avoid an initialization crash on finding an empty registry. 

22. MESTROKEELEMENT and STROKEELEMENT were applying a small length to points (zero-length line strings) if 
they happened to be included in the input selection set. These commands now ignore points. 

23. The 3DOFFSET MARKOFF command was missing. A command dispatch table error was fixed to reactivate it. 

24. The selection set scanner and class editor have added error checking (for example, for deleted elements) and for 
fetching of outermost parent element.  

25. Prior to 6.7, DATEM PROFILE was turning off undo processing. Cell names might have been incorrectly resolved 
due to a termination problem. 

26. The cell library utility was not correctly scaling placed cells. The fixes affect DTM PROFILE and XSECT Cell 
placement (Mode). 

27. Legacy keyins were removed: 2DPSQR and 3DPSQR. These commands did not do anything except show up in 
the keyin browser. 

28. In CHANGE ATTRIBUTES, the new attributes symbology was being reset to defaults (even when picking an 
element). This has been fixed. 

 

 




